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Notices
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product, program, or service. 
IBM may have patents or pending patent applications covering subject matter described in this document. The 
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U.S.A.
For license inquiries regarding double-byte character set (DBCS) information, contact the IBM Intellectual Prop-
erty Department in your country or send written inquiries to: 
IBM World Trade Asia Corporation 
Licensing 
2-31 Roppongi 3-chome, Minato-ku 
Tokyo 106-0032, Japan 
The following paragraph does not apply to the United Kingdom or any other country where such provisions 
are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES 
THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MER-
CHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of ex-
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About this Manual

Welcome to version 4.3 of IBM® Rational® Tau®, the world's leading model development 
application.

This manual introduces you to Tau concepts to help you get started.

Structure of this 
Manual

This manual is divided up into the following chapters:

• Chapter 1 describes how to install IBM Rational Tau.

• Chapter 2 describes specific settings for Rational Tau on UNIX.

• Chapter 3 describes how to to contact the IBM Rational Customer Support.

Typographical Conventions
The following typographical conventions are used in this manual:
 

Typeface or 
Symbol

Meaning

Bold Book titles, important items, and items that you can select, including 
buttons and menus. For example: Click Yes to continue.

Courier Commands, files, and directories; computer output. For example: Edit 
your .properties file.

> A menu choice. For example: Select File > Open. This means select the 
File menu, then select the Open command from it.
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1 Installing IBM Rational Tau 

• Before You Install

• Installing IBM Rational Tau in Windows

• Installing IBM Rational Tau on UNIX

• Install a GNU C Compiler (Windows Only)

• Start IBM Rational Tau

Before You Install Administrator privileges required
For a successful installation of IBM Rational Tau, you must have access to a computer account with 
system administrator privileges.

About license keys and installation
IBM Rational Tau uses FLEXnet for licensing. This means that you will need a FLEXnet license key 
to be able to use IBM Rational Tau. Depending on your type of license agreement, the license 
information may already have been delivered to you by e-mail. If you are a new user and this is your 
first license agreement, that is probably not the case.

During installation, it is assumed that you have the license information at hand, at least hostname and 
port number. You may add the license information later and do not need to install again.

See also: Read the document “IBM Rational Lifecycle Solutions - Licensing Guide“ for information about 
licensing.

Installing IBM 
Rational Tau in 
Windows

In the following it is assumed that the DVD drive is mounted on D:\win_clients\tau (or 
that D:\win_clients\tau is the place where you have downloaded the software from the IBM 
Rational support web). 

Note: The GNU C Compiler does not support space characters in file names or folders. For this 
reason you are limited to designate an installation folder name that meets this constraint. 
This has an impact on both the installation of Tau and the installation of GCC.

Install IBM Rational Tau in Windows
1. Log on as administrator or make sure that you have administrative privileges.

2. Exit all running Windows programs.

3. A welcome screen will automatically be opened when inserting the DVD, where you can select 
to start the installation.

Note: If this is not started automatically, or if you have downloaded the software from the IBM 
Rational support web, double-click D:\win_clients\tau\setup.exe
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Installing IBM 
Rational Tau in 
silent mode in 
Windows

In the following it is assumed that the DVD drive is mounted on D:\win_clients\tau (or 
that D:\win_clients\tau is the place where you have downloaded the software from the IBM 
Rational support web). 

Install IBM Rational Tau in silent mode in Windows
Depending on what kind of installation file you have, non-interactive installation (also known as 
silent installation) should be done in different ways. Tau can be installed using a *.msi file or a 
setup.exe file.

If *.msi file:

>msiexec /i "IBM Rational Tau 4.3.msi" /qn

If setup.exe:

>setup.exe /s /v/qn

Full msiexec documentation is available on the internet.

Installing IBM 
Rational Tau on 
UNIX

Install IBM Rational Tau on UNIX
1. Log on to the UNIX host on which you want to install IBM Rational Tau.

2. Mount the DVD (Volume 4) or download and untar the software from the IBM Rational 
support web.

3. Execute the installation script from the directory Tau/unix on the DVD:

$ ./tauinst.cd

The installation script will start and guide you through the rest of the setup.

License environment on UNIX
During installation, you will be asked for the license server and port number used. You find this 
information on the first line of the FLEXnet license file. The entered information is verified and if a 
valid license is found a file license.dat is created in the installation directory. This file defines the 
license environment for Rational Tau such that any user can start Rational Tau directly without 
setting any license environment variables.

If the servername and/or port number is not available or the license cannot be verified a file 
license.txt will be created in the installation directory. Once you have the correct information replace 
servername and port number in this file with the real values and rename the file to license.dat.

Set up printers and windows appearance on UNIX (optional)
Before you start using Tau on UNIX, you may want to set up PostScript printers. It is also possible 
to set up the appearance of the windows used by Tau (this can also be done later on). Printers and 
window appearances are set up by using the Control Panel that is supplied with Tau. Refer to 
“Control Panel” on page 9.
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Install a GNU C 
Compiler 
(Windows Only)

If you plan to use the Model Verifier feature and you do not have any supported C/C++ compiler 
installed you can install the free GNU C Compiler (GCC) to run the Model Verifier.

The order in which you install Tau and GCC is not significant.

Note: The GNU C Compiler does not support space characters in file names or folders. For this 
reason you are limited to designate an installation folder name that meets this constraint. 
This has an impact on both the installation of Tau and the installation of GCC.

Install GCC 1. Install GCC from the Cygwin homepage: 
http://www.cygwin.com 

2. Enter the Cygwin Setup (Window name) 

• Click Next

3. Choose Installation Type 

• Install from Internet 
• Click Next 

4. Choose Installation Directory 

• Root Directory: Use the default (C:\Cygwin), make sure there are no spaces in this path 
Install For: All users (the default)  
Default Text File Type: UNIX (this is the default) 

• Click Next 

5. Select Local Package Directory 

• Local Package Directory: C:\tmp (for example), make sure there are no spaces in this path. 
This is where the downloaded files are placed. Can be removed after installation is done.

• Click Next 

6. Select Connection Type. If necessary contact your network administrator for further help.

• Click Next 

7. Choose Download Site(s) 

• Select a location near you for the best performance. 
• Click Next 

8. Select Packages 

• The Default settings are NOT sufficient. In order to be get the compiler and make tools 
click on the Default to the right of Devel in the configuration column (be patient - this 
takes time) until it says 'Install' (Figure 1 on page 6).

• Click Next

http://www.cygwin.com 
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After downloading/installing is done
1. Create Icons 

• Create Icon On Desktop (Default is on) 
• Add icon to Start Menu (Default is on) 
• Finish - this causes the “Cygwin Setup Post-Install Script” to run (this may take a few 

moments). 

2. Cygwin Setup 

• OK 

3. Add the “bin” directory path to the beginning of the PATH environment variable, for example:

C:\Cygwin\bin;%SystemRoot%\system32;...

Installation is complete.

Un-install GCC
1. Follow the same procedure as when installing except that when you select install packages you 

should click the top node until Default has changed to Uninstall.

Start IBM 
Rational Tau

Start IBM Rational Tau in Windows
Start IBM Rational Tau from the Start menu. In the Programs submenu choose IBM Rational and 
click Tau 4.3 

Figure 1: Select Packages
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Start 4.3 on UNIX
After the environment is set up, start IBM Rational Tau by typing the full path name:

<installation path>/bin/tau



8 IBM Rational Tau Installation Guide



9

2 Setting up Rational Tau on UNIX

This chapter contains information about how to set up your UNIX environment for Rational Tau.

• Rational Tau and MainWin

• Control Panel

• Floating toolbars

Rational Tau and 
MainWin

Rational Tau on UNIX platforms uses a third-party software, MainWin, that provides access to the 
Win32 API on UNIX environments. Hence, through MainWin, Rational Tau is given a nearly 
identical behavior and look-and-feel on UNIX as on Windows, the exceptions being described in 
“Control Panel” on page 9 and “Floating toolbars” on page 13. 

Registry The subset of the Windows Registry that is required for applications that use MainWin to run (such 
as Rational Tau) is, although available to the end user through the regedit application, not 
intended to be modified. 

Note: Do not, unless specifically instructed to do so, modify or remove any Registry keys. 
Otherwise it may result into a corrupt installation of Rational Tau.

Control Panel The Control Panel (implemented by MainWin) is available with Rational Tau for the users’ 
convenience. It contains a collection of utilities that allow to set up properties in a similar fashion as 
would have been done in a Windows environment. 

Figure 2: The Control Panel
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Starting the control panel
The Control Panel is started with the command: mwcontrol (mwcontrol is located in the 
bin directory of your Rational Tau installation). 

This command opens a window holding icons that have an appearance and functionality similar to 
their equivalence in the Windows Control Panel.

Only the Printers and Display settings are meaningful to use in the context of Rational Tau.

Setting the appearance of Rational Tau windows
The Display applet implements a subset of the Windows Display Properties. Use the Display applet 
should you want to configure the appearance of the windows used by Rational Tau applications 
(such windows font size and family, colors and sizes of menu bars, scrollbars and buttons etc.) 

Figure 3: Setting the appearance of Rational Tau
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When you make changes using the Display applet, the changes only affect Rational Tau sessions that 
you start after you have saved the Display changes. Rational Tau sessions that were running when 
you changed the Display must be restarted for your changes to take effect.

Note: The Display Properties does not affect your UNIX desktop. Neither does it impact the 
color, spacing and font properties used for diagrams managed by Rational Tau – to change 
such properties, use the Options command from the Tools menu in Rational Tau. 

Setting up printers
The Printers applet is similar to the Windows Printers applet. However, unlike Windows, when 
setting up a printer you do not map an actual printer for use with Rational Tau. Instead, you map a 
print request to a proper print command on your UNIX host. Thus, the procedure for adding new 
print capabilities differs slightly from that on Windows.

Note: Changes made using the Printers applet affect Rational Tau sessions running on the same 
machine as soon as you save the changes. Instances of Rational Tau running on other 
machines must be restarted for the changes to take effect.

PostScript printer 
description files

PostScript Printer Description (PPD) files describe how to use features that are special for a specific 
PostScript printer. So, to take advantage of your printer's specific features – for example, duplex 
printing or paper tray selection – you need a PPD file. Most printer vendors provide PPD files for 
their printers. For your convenience, a large subset of the PPD files that are included with Windows 
is supplied with Rational Tau. In addition, a PPD file for generic PostScript printers, which should 
allow you to print on any PostScript printer, is also provided.

The Printers applet also includes an “Add New Printer” wizard, described below.

Note: If you already have a printer installed with an application that uses a previous version of 
Mainwin, then you do not need to add the same printer again. The Printers applet now 
includes an option, from the Tools menu, to import existing printers. The imported 
printers will be associated with a default PPD file, and may not access all the printer's 
features.

Figure 4: Setting up printers
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Add New Printer 1. Start by launching the Control Panel (by typing the mwcontrol command) and double-click 
Printers. 

2. Double-click Add New Printer to start the Add New Printer wizard. 

• At any time, the Add New Printer can be browsed back and forward using the Next and 
Back buttons.

3. Click Next to specify the UNIX printer of your choice. 

• A list of the printers defined on the UNIX host appears at the bottom of the dialog, along 
with their descriptions. The list of printers is extracted from the /etc/printcap file, 
which contains a list of all printers on the network to which your UNIX host has access. The 
printcap file is used on all UNIX platforms as the central location for specifying printers. 
It is configured and maintained by the system administrator. 

• If the printer you want to add is on the list, simply select it.
• To add a printer that does not appear on the list, type the UNIX name of the printer in the 

UNIX printer text input field.

4. Click Next in order to specify the default Print Command for the selected printer. 

• Usually, the default command is the one you should use. You should ask your system 
administrator before changing this command.

• If you manually added a UNIX name of a printer in the previous step, the print command 
will automatically use that name.

5. Click Next to specify the manufacturer and model of your printer, and the appropriate PPD file 
to use.

• If you have your own PPD file, then click Choose File to locate your PPD file. After 
specifying the name and location of the file (using full path name), click OK. 

• You must either have write permission to the directory $MWHOME/system/ppd, or you 
must set the MWPPD_DIR environment variable to a directory to which you have write 
permission.

• If you do not select anything in the Choose PPD File page, then a default generic PPD file is 
automatically selected.

6. Click Next, which allows you to specify a printer name and description of your own.

• The Add New Printer wizard provides a default printer name, which you may modify in the 
Printer Name text box.

• The Printer Description text box has the same functionality as on Microsoft Windows. This 
field may be left blank.

7. Click Next and decide whether you want this printer to be your default printer. 

• This Default Printer page will not appear in the wizard if this is the first printer you are 
setting up. First when adding another printer, then you will be provided the option to 
choose your default printer.

8. Click Next. Now the wizard asks you if you want to print a test page – like in Windows – that 
supplies you with various information, such as the features of the added printer.

9. Click Next and verify that the information you specified in the Add New Printer wizard is 
correct. 

• If you are satisfied with the settings, click Finish. 
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• Otherwise, click Back to change the settings.
The printer you added now appears in the Printers applet, among the previously added printers. 

Floating toolbars When running Rational Tau applications that have floating toolbars, such toolbars behave differently 
on UNIX from their behavior on Windows. 

Behavior on Windows Behavior on UNIX

Double-clicking the title bar of a floating 
toolbar window returns the toolbar to its 
original position on the application's window, 
below the menu bar.

Double-clicking the title bar of a floating 
toolbar window does not do anything. To 
return the toolbar to its location on the 
application window, click the window system 
menu at the top left corner of the toolbar 
window and select Redock.

When dragging a floating toolbar window over 
the toolbar area of the application window, a 
rectangle appears to indicate what the size and 
location of the toolbar would be should it be 
dropped in that position.

When dragging a floating toolbar window over 
the toolbar area of the application window, no 
rectangle appears to indicate the size and 
location of the toolbar in its place on the 
application window. Instead, the floating 
toolbar is dragged. When dropped, the toolbar 
is correctly placed inside the application's 
window.



14 IBM Rational Tau Installation Guide 4.3



15

3 Contacting Customer Support

If the self-help resources have not provided a resolution to your problem, you can contact IBM® 
Rational® Software Support for assistance in resolving product issues.

Before you 
contact Customer 
Support

To submit your problem to IBM Rational Software Support, you must have an active Passport 
Advantage® software maintenance agreement. Passport Advantage is the IBM comprehensive 
software licensing and software maintenance (product upgrades and technical support) offering. You 
can enroll online in Passport Advantage from 
lhttp://www.ibm.com/software/lotus/passportadvantage/howtoenroll.htm

To learn more about Passport Advantage, visit the Passport Advantage FAQs at 
http://www.ibm.com/software/lotus/passportadvantage/brochures_faqs_quickguides.html.

For further assistance, contact your IBM representative.

To submit your problem online (from the IBM Web site) to IBM Rational Software Support, you 
must additionally:

• Be a registered user on the IBM Rational Software Support Web site. For details about 
registering, go to http://www.ibm.com/software/support/.

• Be listed as an authorized caller in the service request tool.

Submitting 
Problems

To submit your problem to IBM Rational Software Support:

1. Determine the business impact of your problem. When you report a problem to IBM, you are 
asked to supply a severity level. Therefore, you need to understand and assess the business 
impact of the problem that you are reporting.

Use the following table to determine the severity level 

Severity Description

1 The problem has a critical business impact: You are unable to 
use the program, resulting in a critical impact on operations. 
This condition requires an immediate solution.

http://www.ibm.com/software/lotus/passportadvantage/howtoenroll.html
http://www.ibm.com/software/lotus/passportadvantage/brochures_faqs_quickguides.html
http://www-01.ibm.com/software/support/
http://www-01.ibm.com/software/support/
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2. Describe your problem and gather background information, When describing a problem to IBM, 
be as specific as possible. Include all relevant background information so that IBM Rational 
Software Support specialists can help you solve the problem efficiently. To save time, know the 
answers to these questions:

• What software versions were you running when the problem occurred?
To determine the exact product name and versio
n, use the option applicable to you: 

• Start the IBM Installation Manager and select File > View Installed Packages. Expand a 
package group and select a package to see the package name and version number. 

Start your product, and click Help > About to see the offering name and version number. 
• What is your operating system and version number (including any service packs or patches)? 
• Do you have logs, traces, and messages that are related to the problem symptoms? 
• Can you recreate the problem? If so, what steps do you perform to recreate the problem? 

• Did you make any changes to the system? For example, did you make changes to the 
hardware, operating system, networking software, or other system components? 

• Are you currently using a workaround for the problem? If so, be prepared to describe the 
workaround when you report the problem.

3. Submit your problem to IBM Rational Software Support. You can submit your problem to IBM 
Rational Software Support in the following ways:

• Online: Go to the IBM Rational Software Support Web site at 
https://www.ibm.com/software/rational/support/ and in the Rational support task 
navigator, click Open Service Request. Select the electronic problem reporting tool, and 
open a Problem Management Record (PMR), describing the problem accurately in your own 
words.

• For more information about opening a service request, go to 
http://www.ibm.com/software/support/help.html

• You can also open an online service request using the IBM Support Assistant. For more 
information, go to http://www.ibm.com/software/support/isa/faq.html.

• By phone: For the phone number to call in your country or region, go to the IBM directory 
of worldwide contacts at http://www.ibm.com/planetwide/ and click the name of your 
country or geographic region. 

2 This problem has a significant business impact: The program is 
usable, but it is severely limited.

3 The problem has some business impact: The program is 
usable, but less significant features (not critical to operations) 
are unavailable.

4 The problem has minimal business impact: The problem 
causes little impact on operations or a reasonable 
circumvention to the problem was implemented

Severity Description

https://www.ibm.com/software/rational/support/
https://www.ibm.com/software/rational/support/
http://www.ibm.com/software/support/help.html
http://www.ibm.com/software/support/help.html
http://www-01.ibm.com/software/support/isa/faq.html
http://www-01.ibm.com/software/support/isa/faq.html
http://www.ibm.com/planetwide/
http://www.ibm.com/planetwide/
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• Through your IBM Representative: If you cannot access IBM Rational Software Support 
online or by phone, contact your IBM Representative. If necessary, your IBM 
Representative can open a service request for you. You can find complete contact 
information for each country at http://www.ibm.com/planetwide/.

If the problem you submit is for a software defect or for missing or inaccurate documentation, 
IBM Rational Software Support creates an Authorized Program Analysis Report (APAR). The 
APAR describes the problem in detail. Whenever possible, IBM Rational Software Support 
provides a workaround that you can implement until the APAR is resolved and a fix is delivered. 
IBM publishes resolved APARs on the IBM Rational Software Support Web site daily, so that 
other users who experience the same problem can benefit from the same resolution.

http://www.ibm.com/planetwide/
http://www.ibm.com/planetwide/
http://www.ibm.com/planetwide/
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